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Click	Draft	Angle	.The	Draft	Definition	dialog	box	appears.	An	arrow	appears	on	a	plane,	indicating	the	default	pulling	direction.	Select	Selection	by	neutral	face	to	determine	the	selection	mode.	Select	the	upper	face	as	the	neutral	element.	This	selection	allows	the	application	to	detect	the	face	to	be	drafted.	The	neutral	element	is	now	displayed	in
blue,	the	neutral	curve	is	in	pink.	The	faces	to	be	drafted	are	in	dark	red.	The	default	angle	value	is	5.	Enter	7	degrees	as	the	new	angle	value.	The	new	angle	value	is	displayed	in	the	geometry.	Click	Preview	to	see	the	draft	to	be	created.	Click	More	to	access	additional	options.	To	know	how	to	use	the	options	Parting	Element	and	Draft	Form,	see
Drafts	with	Parting	Elements	in	Part	Design	User	guide.	Click	the	Limiting	Elements	box.	While	drafting	a	face,	you	can	limit	it	by	selecting	one	or	more	faces	or	planes	that	intersect	it	completely.	Select	Plane.1	as	the	limiting	element.	The	arrow	points	to	the	portion	of	material	that	will	be	kept	after	performing	the	operation.	Select	Plane.2	as	the
second	limiting	element.	Note	that	the	number	of	limiting	elements	you	select	is	indicated	in	the	dialog	box,	just	in	front	of	the	Limiting	Elements	box.	Click	the	arrow	to	reverse	its	direction,	and	therefore	retain	the	opposite	side	of	the	feature.	Click	OK	to	confirm	the	operation.	The	faces	are	drafted	but	the	part	areas	included	between	both	limiting
planes	have	not	been	modified,	as	specified	through	the	limiting	element	option.	CATIAs	innovative	CAD	software	allows	users	to	create	a	wide	range	of	precision	parts	quickly	and	effectively.	But	while	CATIAs	modeling	tools	may	allow	you	to	check	the	functionality	of	your	finished	components,	you	must	also	ensure	that	your	parts	can	be	successfully
removed	from	their	molds.	With	CATIA	Draft	Analysis,	draft	angles	can	be	evaluated	and	optimized	for	your	design	for	easy	ejection.	Here	is	a	brief	guide	on	how	to	make	use	of	this	intuitive	feature.The	Keys	to	CATIA	Draft	AnalysisTo	begin,	you	need	to	have	a	finished	3D	model	in	CATIAs	Workbench.	From	here,	you	enter	Material	Mode	and	access
the	CATIA	Draft	Analysis	box.	Amongst	other	details,	the	box	will	show	the	color	scale	and	the	upper	and	lower	limit	values	for	draft	analysis.	With	this	tool,	you	can	determine	whether	your	draft	angle	is	positive	or	negative	and	thus	where	the	parting	line	and/or	shutoff	for	the	part	should	be.	We	use	these	insights	to	specify	surfaces,	pull	direction,
and	the	draft	angle	required	during	the	physical	prototyping	stage.The	analysis	tool	works	by	assigning	different	color	ranges	to	the	3D	model.	By	following	these	signals	you	can	confirm	that	draft	directions	at	each	point	fall	within	the	specified	parameters	for	your	part.	These	parameters	can	always	be	adjusted	through	the	unit	settings.	It	is
important	to	note	that	color	accuracy	can	vary	according	to	the	video	card	used,	so	if	youre	seeing	a	color	representation	that	doesnt	match	up	to	the	stated	values	then	this	may	just	be	a	display	error.You	can	perform	a	draft	analysis	on	any	surface	of	your	model.	In	order	to	select	a	surface,	check	the	On	the	Fly	box	and	hover	over	the	intended
surface.	Once	you	have	highlighted	a	surface,	corresponding	details	will	show	up	in	the	draft	analysis	box.	The	parameters	option	should	show	the	direction	in	which	the	component	will	be	ejected	from	its	tool.	The	pull	will	always	be	perpendicular	to	the	plane	of	your	surface.	You	can	click	the	Inverse	button	to	reverse	the	draft	direction.Once	the
direction	has	been	set	you	can	set	minimum	limit	against	which	the	draft	angle	will	be	measured	on	various	surfaces.	For	example,	if	you	set	this	parameter	to	3	degrees	then	all	surfaces	with	an	angle	of	3	degrees	or	higher	in	the	direction	of	the	pull	will	show	up	as	positive,	while	all	surfaces	with	an	angle	of	3	degrees	or	higher	away	from	the	pull
will	show	up	as	negative.	You	can	see	the	colors	that	correspond	to	each	value	in	the	quick	mode	option	box.Remember,	there	will	always	be	a	negative	and	positive	face	to	your	part,	your	sole	purpose	here	is	to	identify	any	surfaces	that	require	further	adjustment	to	fall	in	line	with	their	corresponding	plane.As	you	can	see,	theres	a	lot	to	unpack
when	it	comes	to	CATIA	Draft	Analysis.	For	more	information	on	how	we	provide	outsourced	CATIA	design	services	or	an	estimate	on	our	CAD	services	feel	free	to	contact	us.	Were	always	ready	to	help.	Contextual	commands	creating	the	pulling	directions	you	need	are	available	from	the	Selection	field:	Create	Line:	For	more	information,	see
Creating	Lines.	Create	Plane:	see	Creating	Planes.	X	Axis:	the	X	axis	of	the	current	coordinate	system	origin	(0,0,0)	becomes	the	direction.	Y	Axis:	the	Y	axis	of	the	current	coordinate	system	origin	(0,0,0)	becomes	the	direction.	Z	Axis:	the	Z	axis	of	the	current	coordinate	system	origin	(0,0,0)	becomes	the	direction.	If	you	create	any	of	these	elements,
the	application	then	displays	the	corresponding	icon	next	to	the	Selection	field.	Clicking	this	icon	enables	you	to	edit	the	element.Click	Draft	Analysis	in	the	Shape	Analysis	toolbar.	The	Draft	Analysis	dialog	box	is	displayed.	Set	up	your	analysis:	Select	a	surface	for	analysis.	The	quick	analysis	is	displayed	on	the	surface.The	draft	direction	is	the	w/z
axis	of	the	compass.	In	the	Mode	area	of	the	dialog	box,	select	Full	Analysis	Mode	.	The	color	scale	and	range	of	values	in	the	Draft	Analysis.x	dialog	box	are	expanded.The	corresponding	colors	are	displayed	on	the	surface.	Optional:	Modify	the	colors	and/or	values	in	the	color	scale	(right-click	a	color	or	value).	In	the	Display	area	of	the	dialog	box,
select	On	the	Fly	and	move	the	pointer	over	the	surface.	The	following	information	about	the	current	pointer	location	is	displayed:Green	arrow,	N:	The	normal	to	the	surface	Red	arrow,	D:	The	draft	direction	Blue	arrow,	T:	The	tangent	to	the	surface	Circles:	The	plane	tangent	to	the	surface	Value	(reverse	highlighted):	The	angle	between	the	draft
direction	and	the	tangent	to	the	surface	(the	value	is	expressed	in	the	units	set	in	Tools	>	Options	>	General	>	Parameters	>	Units	tab)	The	cone	Value	(unhighlighted):	The	cone	angle	(the	angle	between	the	axis	of	the	cone	and	the	draft	direction	D)	As	you	move	the	pointer	over	the	surface,	this	information	is	updated	dynamically.	Note	that	you	can
activate	the	On	the	fly	option	even	when	not	visualizing	the	materials.	It	gives	you	the	tangent	plane	and	the	deviation	value.	Click	Inverse	to	reverse	the	draft	direction.	This	command	affects	all	selected	elements.	Right-click	the	cone	angle	to	display	the	Angle	Tuner	dialog	box	and	then	modify	the	angle	using	the	up/down	arrows.	The	value	is
automatically	updated	in	the	color	scale	dialog	box,	on	the	geometry	and	the	cone	diameter	is	adjusted.The	value	in	the	color	scale	dialog	box	(16.961deg	in	the	example	shown	below)	is	highlighted	in	a	different	color	.	Right-click	the	red	arrow,	D	(draft	direction)	to	display	a	contextual	menu.From	the	contextual	menu	you	can:	Hide/show	the	cone.
Hide/show	the	angle.	Hide/show	the	tangent.	Lock/unlock	the	analysis	position.	Keep	the	point	at	this	location	(a	Point.xxx	appears	in	the	specification	tree).	Define	a	new	draft	direction	and	then	lock	the	direction:	When	you	have	finished	working	with	this	command,	do	one	of	the	following:To	create	the	analysis,	click	OK.	The	analysis	is	added	to	the
specification	tree	where	it	is	identified	as	Command_Name.Analysis.x.The	analysis	will	be	updated	automatically	whenever	you	modify	any	of	the	elements	in	the	analysis	(for	example	when	you	deform	an	element	using	control	points).	To	abandon	the	analysis,	click	Cancel.	Note:	Note	that	settings	are	saved	when	exiting	the	command,	and
redisplayed	when	you	select	Draft	Analysis	again.	Be	careful,	when	selecting	the	direction,	not	to	deselect	the	analyzed	element.	A	draft	analysis	can	be	performed	just	as	well	on	a	set	of	surfaces.	If	an	element	belongs	to	an	analysis,	it	cannot	be	selected	simultaneously	for	another	analysis;	you	need	to	remove	the	current	analysis	by	deselecting	the
element	to	be	able	to	use	it	again.	In	some	cases,	even	though	the	rendering	style	is	properly	set,	it	may	happen	that	the	analysis	results	are	not	visible.	Check	that	the	geometry	is	up-to-date,	or	perform	an	update	on	the	involved	geometric	elements.	The	analysis	results	depend	of	the	current	object.	May	you	want	to	change	the	scope	of	analysis,	use
the	Define	in	Work	object	contextual	command.	Click	Draft	Analysis	in	the	Shape	Analysis	toolbar.	The	Draft	Analysis	dialog	box	is	displayed.	Set	up	your	analysis:	Select	a	surface	for	analysis.	The	quick	analysis	is	displayed	on	the	surface.The	draft	direction	is	the	w/z	axis	of	the	compass.	In	the	Mode	area	of	the	dialog	box,	select	Full	Analysis	Mode	.
The	color	scale	and	range	of	values	in	the	Draft	Analysis.x	dialog	box	are	expanded.The	corresponding	colors	are	displayed	on	the	surface.	Optional:	Modify	the	colors	and/or	values	in	the	color	scale	(right-click	a	color	or	value).	In	the	Display	area	of	the	dialog	box,	select	On	the	Fly	and	move	the	pointer	over	the	surface.	The	following	information
about	the	current	pointer	location	is	displayed:Green	arrow,	N:	The	normal	to	the	surface	Red	arrow,	D:	The	draft	direction	Blue	arrow,	T:	The	tangent	to	the	surface	Circles:	The	plane	tangent	to	the	surface	Value	(reverse	highlighted):	The	angle	between	the	draft	direction	and	the	tangent	to	the	surface	(the	value	is	expressed	in	the	units	set	in	Tools
>	Options	>	General	>	Parameters	>	Units	tab)	The	cone	Value	(unhighlighted):	The	cone	angle	(the	angle	between	the	axis	of	the	cone	and	the	draft	direction	D)	As	you	move	the	pointer	over	the	surface,	this	information	is	updated	dynamically.	Note	that	you	can	activate	the	On	the	fly	option	even	when	not	visualizing	the	materials.	It	gives	you	the
tangent	plane	and	the	deviation	value.	Click	Inverse	to	reverse	the	draft	direction.	This	command	affects	all	selected	elements.	Right-click	the	cone	angle	to	display	the	Angle	Tuner	dialog	box	and	then	modify	the	angle	using	the	up/down	arrows.	The	value	is	automatically	updated	in	the	color	scale	dialog	box,	on	the	geometry	and	the	cone	diameter	is
adjusted.The	value	in	the	color	scale	dialog	box	(16.961deg	in	the	example	shown	below)	is	highlighted	in	a	different	color	.	Right-click	the	red	arrow,	D	(draft	direction)	to	display	a	contextual	menu.From	the	contextual	menu	you	can:	Hide/show	the	cone.	Hide/show	the	angle.	Hide/show	the	tangent.	Lock/unlock	the	analysis	position.	Keep	the	point
at	this	location	(a	Point.xxx	appears	in	the	specification	tree).	Define	a	new	draft	direction	and	then	lock	the	direction:	When	you	have	finished	working	with	this	command,	do	one	of	the	following:To	create	the	analysis,	click	OK.	The	analysis	is	added	to	the	specification	tree	where	it	is	identified	as	Command_Name.Analysis.x.The	analysis	will	be
updated	automatically	whenever	you	modify	any	of	the	elements	in	the	analysis	(for	example	when	you	deform	an	element	using	control	points).	To	abandon	the	analysis,	click	Cancel.	Note:	Note	that	settings	are	saved	when	exiting	the	command,	and	redisplayed	when	you	select	Draft	Analysis	again.	Be	careful,	when	selecting	the	direction,	not	to
deselect	the	analyzed	element.	A	draft	analysis	can	be	performed	just	as	well	on	a	set	of	surfaces.	If	an	element	belongs	to	an	analysis,	it	cannot	be	selected	simultaneously	for	another	analysis;	you	need	to	remove	the	current	analysis	by	deselecting	the	element	to	be	able	to	use	it	again.	In	some	cases,	even	though	the	rendering	style	is	properly	set,	it
may	happen	that	the	analysis	results	are	not	visible.	Check	that	the	geometry	is	up-to-date,	or	perform	an	update	on	the	involved	geometric	elements.	The	analysis	results	depend	of	the	current	object.	May	you	want	to	change	the	scope	of	analysis,	use	the	Define	in	Work	object	contextual	command.	In	this	post,	were	going	to	explore	the	Draft	tool,	a
nifty	feature	that	lets	you	add	draft	angles	to	your	designs,	a	critical	component	in	parts	intended	for	mold	manufacturing.	Once	you	have	your	part	created	as	a	solid	body,	you	can	apply	draft	using	the	CATIA	tool.	Step	1:	Switch	to	the	Part	Design	workbench.	Navigate	to	the	Draft	tool	located	under	the	Dress-Up	Features	drop-down	menu.	Step	2:	A
dialog	box	will	appear.	Here,	select	the	Neutral	Element.	This	will	be	the	plane	or	face	from	which	the	draft	will	be	measured.	Lets	choose	one	of	the	faces	of	our	rectangular	prism.	Step	3:	Next,	its	time	to	select	the	Faces	to	Draft.	These	are	the	faces	to	which	the	draft	will	be	applied.	In	our	case,	well	select	the	two	faces	adjacent	to	the	neutral
element.	Step	4:	Now	enter	the	draft	angle	value.	This	is	the	angle	between	the	drafted	face	and	the	neutral	element.	For	this	tutorial,	lets	enter	a	draft	angle	of	10	degrees.	Then,	hit	the	OK	button.	Just	like	that,	youve	successfully	used	the	Draft	tool!	Youll	notice	that	our	rectangular	prism	now	has	a	taper	or	draft	on	the	two	faces.	The	Draft	tool	is
invaluable	when	designing	parts	for	mold	manufacturing,	as	the	draft	makes	it	easier	to	remove	the	part	from	the	mold.	Remember,	practice	makes	perfect	-	dont	shy	away	from	experimenting	with	different	draft	angled	and	shapes.	I	hope	you	found	this	tutorial	useful	and	are	eager	to	try	out	the	tool	in	your	projects.	If	you	have	any	questions	or
would	like	to	explore	more	CATIA	V5	features,	feel	free	to	reach	out.	Happy	designing!	Technical	Training	EngineerJoshua	is	a	resident	instructor	for	a	large	automotive	OEM,	working	out	of	their	Advanced	Development	Center.	He	implements	customer	specific	training	and	brings	eight	years	of	industry	experience	to	his	classes.	Joshuas	areas	of
expertise	include	Advanced	Part	and	Generative	Shape	Design,	VPM	Navigator	and	Generative	Drafting.	More	Content	by	Joshua	Sands	Note	that	settings	are	saved	when	exiting	the	command,	and	redisplayed	when	you	select	the	Draft	Analysis	icon	again.	Be	careful,	when	selecting	the	direction,	not	to	deselect	the	analyzed	element.	A	draft	analysis
can	be	performed	just	as	well	on	a	set	of	surfaces.	If	an	element	belongs	to	an	analysis,	it	cannot	be	selected	simultaneously	for	another	analysis,	you	need	to	remove	the	current	analysis	by	deselecting	the	element	to	be	able	to	use	it	again.	In	some	cases,	even	though	the	rendering	style	is	properly	set,	it	may	happen	that	the	analysis	results	are	not
visible.	Check	that	the	geometry	is	up-to-date,	or	perform	an	update	on	the	involved	geometric	elements.	The	analysis	results	depend	of	the	current	object.	May	you	want	to	change	the	scope	of	analysis,	use	the	Define	in	Work	object	contextual	command.	The	draft	analysis	technique	is	used	to	analyze	whether	our	part	model	created	in	CAD	is
manufacturable	based	on	the	draft	condition	applied.	Here	the	part	should	get	easily	removed	from	the	panel	dies	(in	case	of	Sheet	metal	part)	or	Mold	(in	case	of	plastic).No	parts	can	be	ejected	from	the	tool	if	it	is	having	a	straight	90-degree	profile	from	its	base	surface.	A	small	draft	angle	is	provided	to	each	and	every	area	of	the	component	in
order	to	get	easy	removal	of	the	component	from	the	tool.Here	we	are	providing	a	direction	in	which	components	should	eject	in	order	to	get	easy	removal	of	components	from	the	tool.	In	other	words,	it	also	lets	us	know	whether	the	model	is	having	a	draft	angle	and	how	much	is	the	draft	angle	from	the	tool	direction.The	Types	of	Components	for
Draft	Analysis	Draft	analysis	is	performed	on	the	components	where	the	ejection	of	materials	happens	after	the	material	is	made	inside	the	tools.	In	the	case	of	Automotive	Sheet	Metal	manufacturing,	the	blank	sheet	after	turning	into	automotive	panels	like	Hood,	Fender,	Roof,	Side	Doors,	Back	Doors	etc.	need	to	be	removed	from	Panel	Dies.	If	a
considerable	amount	of	draft	angle	is	not	provided,	the	removal	of	components	from	the	tool	will	be	difficult.	Its	the	same	in	the	case	of	mold(plastic	component)	after	getting	filled	inside	the	core	and	cavity,	it	needs	to	get	ejected	easily	with	the	help	of	ejectors.	Procedure	To	Perform	A	Draft	Analysis	in	Catia	Step	1Change	the	view	mode	to	Customize
View	Parameters	and	select	the	Material	option	from	the	Mesh.	Step	2	Next,	you	need	to	create	a	rough	line,	without	considering	a	particular	direction	or	parameters.	The	direction	of	the	line	may	vary	from	component	to	component.	To	make	the	Draft	Analysis	easier,	it	will	be	better	if	the	line	is	created	from	the	CG	point.	For	that,	we	need	to	select
the	measure	inertia	option	from	the	measuring	toolbar.	After	that	select	the	body	from	the	tree	for	the	Measure	Inertia	dialogue	box.	The	CG	point	is	represented	inside	a	box	on	the	intersection	point	of	red,	blue,	and	green.	If	we	want	to	get	to	that	point	permanently,	we	need	to	select	the	created	geometry	and	select	both	the	center	of	gravity	and
the	Axis	system.	Step	3	Create	a	random	line	from	the	CG	point	using	the	point	and	direction	option	from	the	line	command.	Step	4	Draft	Analysis	options	are	available	inside	the	following	workbenches:Part	Design	Generative	Shape	Design	Wireframe	and	Surface	for	BuildingFreeStyle	Shaper	Insert	>	Analysis	>	Draft	AnalysisThe	draft	Analysis
dialog	box	with	colour	scale	(with	quick	analysis	mode)	appears	on	the	screen.	So	the	first	mode	option	is	the	quick	analysis	mode	and	the	second	is	the	full	analysis	mode.	Here	the	quick	analysis	mode	is	used.	Change	the	value	of	green	according	to	the	draft	angle	provided	to	the	part.	Here	for	automotive	sheet	metal	components,	the	ideal	draft
angle	is	7	degrees.	Step	5	Drag	the	compass	and	place	it	over	to	the	line.	Select	the	compass	icon	from	the	direction	of	the	Draft	Analysis	dialog	box.	The	compass	may	get	misplaced	from	its	original	position	after	clicking	on	the	compass	icon.	Select	the	compass	again	and	place	it	over	to	the	line	properly	one	more	time.	Step	6	After	placing	it,	click
anywhere	on	the	part.	The	appearance	of	the	component	will	change	afterwards.	To	get	a	clear	picture,	either	we	need	to	adjust	the	compass	by	holding	the	marked	region	of	the	compass	and	dragging	it	towards	the	opposite	direction	or	by	selecting	the	inverses	draft	direction	option	inside	the	direction	of	Draft	Analysis	Step	7	After	getting	the	green
colour	on	the	component,	try	to	adjust	the	compass	using	the	knob,	and	adjust	the	direction	of	the	compass	to	get	green	on	the	entire	top	panel	region.	Try	zooming	in	and	checking	if	each	and	every	region	of	the	panel	is	showing	green,	if	in	some	regions,	red	or	blue	is	showing	instead	of	green,	those	negative	regions	are	below	7	degrees	and	have	no
draft	applied	on	those	regions.	Those	blue	and	red	negative	regions	need	to	be	changed.	Step	8If	we	are	ok	with	the	result,	right-click	on	the	compass	and	lock	its	current	position	using	lock	current	orientation.	Step	9	Click	ok	to	the	draft	analysis	dialog	box	to	close	it.	Double	click	on	the	line	and	right	click	on	the	direction	option	and	change	the	line
direction	to	compass	direction.	The	line	will	get	oriented	along	with	the	previously	locked	compass	draft	direction.	After	the	use,	right-click	again	on	the	compass	and	unlock	it.	Also,	reset	the	compass	using	the	shortcut	Alt	+	v	+	r.	The	compass	will	get	reset	to	its	original	position.	Later	we	can	provide	thickness	to	the	line	and	change	the	appearance
colour	to	green	by	right-clicking	and	selecting	properties	(which	is	an	ideal	colour	used	to	represent	draft	direction).	Exploring	More	Display	OptionsShow	or	Hide	the	Colour	ScaleThe	first	option	inside	the	display	is	to	show	or	hide	the	colour	scale.	This	option	is	used	to	change	the	draft	angle	value	according	to	the	type	of	component	used.	Analysis
under	the	Running	PointThis	option	is	used	to	highlight	the	exact	draft	angle	of	that	face.	For	that,	we	need	to	move	the	point	along	the	faces.	No	Highlight	Representation	/	Light	EffectNo	Highlight	Representation	and	Light	Effect	options	are	used	to	change	the	view	type	to	get	a	clear	highlight	of	the	Draft	Analysis	result.	Draft	Analysis	of	Plastic
ComponentsThe	ideal	draft	angle	for	the	plastic	components	is	3	degrees.	This	may	vary	according	to	the	functional	requirement.	Apart	from	the	draft	angle	consideration,	the	remaining	procedures	for	the	draft	analysis	are	similar	to	the	above-mentioned	steps.	The	draft	angle	provided	for	the	plastic	features	is	0.5	degrees.	This	may	also	get	varied
accordingly.	The	above	figure	shows	the	tooling	direction,	slider	direction,	dog	house	slider	direction,	and	snap	slider	direction	of	the	plastic	component.	This	is	determined	with	the	help	of	draft	analysis	with	a	draft	angle	of	0.5	degrees.	Author	Note	that	settings	are	saved	when	exiting	the	command,	and	redisplayed	when	you	select	the	Draft
Analysis	icon	again.	Be	careful,	when	selecting	the	direction,	not	to	deselect	the	analyzed	element.	A	draft	analysis	can	be	performed	just	as	well	on	a	set	of	surfaces.	If	an	element	belongs	to	an	analysis,	it	cannot	be	selected	simultaneously	for	another	analysis,	you	need	to	remove	the	current	analysis	by	deselecting	the	element	to	be	able	to	use	it
again.	In	some	cases,	even	though	the	rendering	style	is	properly	set,	it	may	happen	that	the	analysis	results	are	not	visible.	Check	that	the	geometry	is	up-to-date,	or	perform	an	update	on	the	involved	geometric	elements.	The	analysis	results	depend	of	the	current	object.	May	you	want	to	change	the	scope	of	analysis,	use	the	Define	in	Work	object
contextual	command.	
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